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1 FMCSA IT Development Division Release

These Release Notes detail information regarding the latest software from the FMCSA IT Development Division.

Introduction

Upgrading the Applications:

· Aspen

· CAPRI

· CaseRite

· CDLIS Access

· eFOTM

· ISS

· PIQ

· SAFETYNET

· UFA

Installation

Installing the IT Development Division Software

Installing Cisco systems VPN Client 4.8

Installing Firebird

Configuring the Application for Power Users

Fixes and Enhancements

· Aspen

· CAPRI

· CaseRite

· CDLIS Access

· eFOTM

· ISS

· PIQ

· Query Central

· SAFETYNET

· UFA

Known Issues

Technical Support
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1.1 Introduction

The latest FMCSA IT Development Division release includes the following software:

New Software and Version Required Upgrade Date
You can upgrade from

version:

Aspen 2.9 December 31, 2007 2.8 or higher

CAPRI 6.6 December 31, 2007 6.5 or higher

CaseRite 3.7.3 December 31, 2007 3.7.2 or higher

CDLIS Access 3.4.1 December 31, 2007 3.4 or higher

eFOTM 2.2 NA 2.1 or higher

ISS 2.12 December 31, 2007 2.11 or higher

PIQ 2.9 December 31, 2007 2.8 or higher

SAFETYNET  3.4 December 31, 2007 3.3 or higher

UFA 2.6.4 December 31, 2007 2.6.3 or higher

Firebird 1.5.1 NA NA

Each of these applications is available for download from the FMCSA Information Systems Web site.

Note  Only the upgrade installer of SAFETYNET 3.4 is available for download. A full, fresh install requires a CD that can be
obtained from FMCSA Technical Support.

These applications have been tested and are supported on the Microsoft Windows 2000 SP 4 and XP SP 2 operating systems.

Please install the software as soon as possible, but no later than the required upgrade date. If you do not have the version
noted in the right column of the above table installed, please uninstall your older version before installing the latest version
(refer to the following upgrading section for more information).

1.2 Upgrading the Applications

1.2.1 Aspen

To upgrade to Aspen 2.9. you must have Aspen 2.8 or higher installed. If you do not have Aspen 2.8 or higher installed, please
uninstall the older version of Aspen before installing Aspen 2.9. As always, remember to back up your work.

Important Note for Level VI Inspectors:: Due to database changes, Level VI inspections performed with a previous
version of  Aspen CANNOT be opened in Aspen 2.9. Before installing Aspen 2.9, all users that perform Level VI inspections
must:

1. Complete ALL unfinished Level VI inspections.

2. Transfer ALL Level VI inspections to SAFER/SAFETYNET.

3. Archive ALL Level VI inspections.

http://infosys.fmcsa.dot.gov/
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After completing steps 1-3, install Aspen 2.9.

IMPORTANT: SAFETYNET MUST be upgraded to version 3.4 BEFORE importing Aspen version 2.9 inspections.

Note To ensure ISS, PIQ, and Aspen work together properly, you must have the following versions installed: Aspen 2.9, ISS
2.12, as well as PIQ 2.9.

1.2.2 CAPRI

To upgrade to CAPRI 6.6 you must have CAPRI 6.5 or higher installed. If you do not have CAPRI 6.5 or higher installed,
please uninstall the older version of CAPRI before installing CAPRI 6.6. Upgrading to CAPRI 6.6 should not result in the loss of
any data. However, it is highly recommended that you perform a backup of all user-generated data before installing CAPRI 6.6.

IMPORTANT: CAPRI 6.6 requires the Firebird database client version 1.5.1. You must uninstall any older Firebird version
before installing Firebird 1.5.1. You must have administrative rights to your computer to install the FMCSA IT Development
Division software.

To uninstall Firebird

1. From the MS Windows Control Panel, Click Add or Remove Programs.

2. Select Firebird and click Remove.

3. Follow the prompts to remove the application.

To install Firebird

1. Download Firebird 1.5.1 from the FMCSA Information Systems Web site .

2. Double-click the Firebird download to start the installation.

3. Follow the prompts using the default settings to install Firebird.

Note  To ensure CAPRI, CaseRite, and UFA work together properly, you must have the following versions installed: CAPRI
6.6, CaseRite 3.7.3, and UFA 2.6.4.

IMPORTANT: Install both Firebird 1.5.1 and CAPRI 6.6 prior to launching CAPRI 6.6 for the first time.

1.2.3 CaseRite

To upgrade to CaseRite 3.7.3, you must have CaseRite 3.7.2 or higher installed. If you do not have CaseRite 3.7.2 or higher
installed, please uninstall the older version of CaseRite before installing CaseRite 3.7.3. As always, remember to back up your
work.

Note  To ensure CAPRI, CaseRite, and UFA work together properly, you must have the following versions installed: CAPRI
6.6, CaseRite 3.7.3, and UFA 2.6.4.

1.2.4 CDLIS Access

To upgrade to CDLIS Access 3.4.1, please uninstall any previous versions of CDLIS Access, and then install CDLIS Access
3.4.1. As always, remember to back up your work.

1.2.5 eFOTM

To upgrade automatically from eFOTM 2.1 to eFOTM 2.2, you must have downloaded the patch to the Automatic Update
function prior to the release of eFOTM 2.2. If you did, eFOTM will automatically update to 2.2 the next time it is opened.

If you did not, please download and install the full version eFOTM 2.2 from the FMCSA Information Systems Web site.

http://infosys.fmcsa.dot.gov/
http://infosys.fmcsa.dot.gov/
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1.2.6 ISS

To upgrade to ISS 2.12, you must have ISS 2.11 or higher installed. If you do not have ISS 2.11 or higher installed, please
uninstall the older version of ISS before installing ISS 2.12. As always, remember to back up your work.

Note To ensure ISS, PIQ, and Aspen work together properly, you must have the following versions installed: Aspen 2.9, ISS
2.12, as well as PIQ 2.9.

1.2.7 PIQ

To upgrade to PIQ 2.9 you must have PIQ 2.8 or higher installed. If you do not have PIQ 2.8 or higher installed, please
uninstall the older version of PIQ before installing PIQ 2.9. As always, remember to back up your work.

Note To ensure ISS, PIQ, and Aspen work together properly, you must have the following versions installed: Aspen 2.9, ISS
2.12, as well as PIQ 2.9.

1.2.8 SAFETYNET

Please refer to the readme.pdf included with the SAFETYNET download for installation/upgrade instructions.

IMPORTANT: SAFETYNET MUST be upgraded to version 3.4 BEFORE importing Aspen version 2.9 inspections.

Note  Only the upgrade installer of SAFETYNET 3.4 is available for download. A full, fresh install requires a CD that can be
obtained from FMCSA Technical Support.

1.2.9 UFA

To upgrade to UFA 2.6.4 you must have UFA 2.6.3 or higher installed. If you do not have UFA 2.6.3 or higher installed, please
uninstall the older version of UFA before installing UFA 2.6.4. As always, remember to back up your work.

Note  To ensure CAPRI, CaseRite, and UFA work together properly, you must have the following versions installed: CAPRI
6.6, CaseRite 3.7.3, and UFA 2.6.4.

1.3 Installation

All FMCSA IT Development Division software must be installed and uninstalled by a user with administrative rights. Before
continuing with the installation, please verify that you have administrative rights on the computer to which you are installing the
applications, or locate your administrator to complete the installation.

1.3.1 Installing the IT Development Division Software

From the FMCSA Information Systems Web site, you will download and launch the individual installers for each application.
These installers will determine if there is adequate disk space.

Note  After completing all installations, you need to restart your computer to enable all systems.

IMPORTANT: Before installing the software, please close all other applications.

To install the FMCSA IT Development Division Software
1. Go to the Software/Documents section of the FMCSA Information Systems Web site (https://infosys.

fmcsa.dot.gov) .
2. Select the link to the software that you wish to download and install.
3. Click the Download Now link.
4. Click Save to save each installation to your local drive.
5. Navigate to each installation on your local drive and double-click to install.
6. Follow the prompts for each installation.
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1.3.2 Installing Cisco systems VPN Client 4.8.0

If you need to access the FMCSA/SAFER systems from a remote site, and do not have a VPN client already installed on your
machine, you will need to download and install the Cisco VPN Client. Before installing, please read the VPN installation
instructions.

1.3.3 Installing Firebird

If you are a first-time CAPRI user, you will need to install Firebird 1.5.1 along with CAPRI.

1.4 Configuring the Application for Power Users

If you are installing these applications to a Windows XP environment for a Power User, you will need to change the user
permissions to enable the Power User to modify application data. Without this ability, Power Users will be unable to access or
update an applications database.

Step 1  Log on to the computer with administrator rights.

Step 2  From the Start menu, select My Computer .

Step 3  From the Tools menu, select Folder Options .

Step 4  Click the View tab.

Step 5  Scroll to the bottom of the list, clear the Use Simple File Sharing check box, and click OK .
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Step 6  Right-click the FMCSA IT Development Division application folder on which you want to change
permissions, for example:

· C:\FSGApps

· C:\CASERITE_ECPS

· The directory where you selected to install the application

Step 7  Select Properties .

Step 8  Click the Security tab.

Step 9  Choose from the following options:

· If Power Users does not appear in the list:

.1.Click Add .
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.2.Type Power Users and click OK .

Note : If From this location does not display your computer name, click the Locations button and
select your computer.

· If the Power User group already appears, go on to step 10 .
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Step 10  Select the Power Users group.

Step 11  Click the Modify box.

Step 12  Click Ok .

1.5 Fixes and Enhancements

This section outlines the various fixes and enhancements that have been made to the FMCSA IT Development Division
release.

1.5.1 Aspen

The Aspen driver/vehicle safety inspection system enables law enforcement agencies to perform roadside safety inspections
and to transfer those inspection results into the State and National data systems.

Important Note for Level VI Inspectors: Due to database changes, Level VI inspections performed with a previous
version of  Aspen CANNOT be opened in Aspen 2.9. Before installing Aspen 2.9, all users that perform Level VI inspections
must:

1. Complete ALL unfinished Level VI inspections.

2. Transfer ALL Level VI inspections to SAFER/SAFETYNET.
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3. Archive ALL Level VI inspections.

After completing steps 1-3, install Aspen 2.9.

Fixes to Aspen 2.9

· An issue that caused the tab order to be incorrect on HM Shipper Window has been fixed.

· An error that caused imports of Trailer Vehicle Makes to be shown as Truck Vehicle Makes has been corrected.

· A fix has been made that corrects the highlighted brake measurements on the Inspection Report.

· An error that caused long Carrier names to overlap the USDOT number on the Inspection Report has been fixed.

Enhancements and Other Modifications to Aspen 2.9

· Aspen has been updated to reflect the potential changes required by the Hours of Service court ruling.

· The CVSA Out of Service Criteria has been added to the Help.

· The Instrument Model field has been increased to display 20 characters in the Aspen Level VI Report.

· The CVSA Decal # field now adds leading zeros to any number less than eight characters long. Decal numbers that
contain letters, are left as entered.

· When present, the ability to scan barcode information and populate Aspen with the Vehicle Type and Company
Number has been added. 

· Inspection levels are now displayed in Roman Numerals.

· Violation handling:

o ALL violations (regular and Level VI violations) now print on page 1 of the Inspection Report

o Only Level VI violations print on the Level VI section of the  Inspection Report

o Level VI violations are considered OOS by default. This can be changed in the VI OOS column on the Violation
tab.

o The Level VI OOS indicator column does not print on the Inspection Report

· The city choices for Nova Scotia have been updated.

· An Edit BIPD Information option ( ) has been added to the Carrier tab. This option allows users to edit
previously entered BIPD information. 

· The default path for archiving has been changed to My Documents.

· The Pasa Special Check information has been added to the Aspen export and transfers.

· The ability to type a number in the Com Port Number setting box in the Barcode Configuration dialog box has been
added.

· On the Vehicle tab, Aspen now requires the user to enter a 4-digit year.

· Aspen will no longer allow inspections to be completed without a start date.

· The Carrier Certification text has been updated to reflect new fine amounts.

· Aspen has been updated to reflect the requirements for Mexican Long-Haul operations. Two warnings have been
added:

o Full 17 character VIN is required for ALL CMV units inspected

o A Valid CVSA Decal is required for ALL CMV units inspected
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· The Aspen SAFETYNET Office IDs have been updated.

Changes to the Violation Lookup Table

· This release of ASPEN and SAFETYNET includes the following new violations:

o 397.101E3 - Driver not in possession of written route plan as required in 397.101(d) - RAM Shipments

o 390.3E -  Failing to comply with all applicable regulations contained in 49 CFR Parts 350-399 / Failing to display a

current CVSA decal as required by 385.103(c)

o 392.9AA2-C - Operating beyond the scope of Operating Authority Granted - Providing prohibited point-to-point

transportation services (Cabotage)

o 393.95A1I - Failure to equip hazardous material vehicle with a fire extinguisher with a minimum UL rating of 10 B:C

o 393.75H - Under inflated tire

To see the complete Violation Table, refer to the Documents section for Aspen on the FMCSA Information Systems Web

site.

1.5.2 CAPRI

The Compliance Analysis and Performance Review Information (CAPRI) system provides a standardized method for
conducting reviews on motor carriers, HM shippers, and cargo tank facilities. It is also used for Safety Audits on new carriers
and Mexican carriers seeking to operate in the United States.

Fixes to CAPRI 6.6

· A fix was made to correct a problem where Part B was being marked as unprinted when the no violations checkbox
was selected.

· A fix has been made so that “NEW ENTRANT SEMINAR” will print on the report as the audit location if selected in Part
A.

· A fix has been made so that drivers marked as intra-state only will be marked on the driver detail report as intra-state.

· A fix was made so that Canada will print correctly on the Report Receipt.  Central America was previously being
printed.

· A fix was made to correct an error that was being generated when a user tried to print the Fitness Ratings Explanation
report on an intrastate carrier.

· A fix has been made so that if reviews/audits are modified after they have been uploaded they will remain on the
“Available List”.  Reviews/audits that have only been opened and not modified will not appear on the available for
upload list.

· A fix has been made so that changes made to Part C after it has been printed will set the part status back to “not
printed”.

· A fix has been applied to prevent errors when manually editing a state violation code.

· A fix has been made so that blank Report titles will not be written to the database when a report is printed.

· A fix has been made so that if the calculated accident rate is greater than 999.99 it will not round up to 1000 for large
values.  The accident rate will be capped at 999.99, this will prevent the user from receiving an Oracle error when
upload the review/audit to MCMIS.

· A fix has been made so that the federal equivalent will not be erased when modifying a custom violation.

· On the Part B report, a fix has been made so that the PDF file will not duplicate the rating information under certain
circumstances.

· A problem has been fixed that was not properly displaying the Notes section on state violations.

· Multiple issues have been fixed on the CTFR screen.  These include:

o Only displaying the manufacturing screens for component manufacturers.

http://infosys.fmcsa.dot.gov/
http://infosys.fmcsa.dot.gov/
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o Component manufacturers and Manufacturing/Assembly types are now being cleared when they are disabled.

o Edit checks are in place to prevent the user from selecting manufacturing activities on old tank types

o Edit checks have been modified for null values.

Enhancements and Other Modifications to CAPRI 6.6

· On the Driver’s Pick list after a driver has been transferred to a worksheet CAPRI will keep the selected drivers
highlighted so they may be transferred to other worksheets without having to be re-selected.

· A change has been made so that when the driver, accident, Shipping Papers, Shipments and Loss & Damage claim
window is opened a blank note will not be created.

· A change has been made on the DQ and HHG worksheet so when a violation is removed, the comment will also be
removed.

· New Planned Action type “Notice of Violation” has been added.  When “Notice of Violation” is selected, user will be
required to enter a case number that follows the same format as the Prosecution Number.

· The ability to add groups to custom violations has been added.  This will allow users to sort the custom violations in
Part B.

· Various edit checks have been modified so if a user presses the CORRECT button in the validation window they will be
sent to the correct location in the application.

· A change has been made on the Worksheet Driver Pick List that once a driver record has been transferred to a
worksheet the driver does not have to be reselected to be transferred to another worksheet. 

· A CTFR edit check has been added so that a Design Certifying Engineer (DCE) is required when the Cargo Tank
Facility Type is Manufacturing.

· The Print Report button has been re-enabled on the Manage Review/Audits grid.

· The shortcut keys in the Safety Audit answer questions tab have been modified.  To select ‘Not Applicable’ users may
use the <CTRL> + <B> keys.

· A change has been made on the Preferences window, SAFETYNET tab so that users cannot enter a SAFETYNET
mailbox ID that does not conform to the mailbox ID standards.

· CAPRI has been modified so that a user can cite 0 violations discovered for a Critical Violation. This was done to meet
the specifications of SAFETEA-LU 4114.  Previous versions of CAPRI would only allow 0 violations discovered to be
entered on non-critical/non-acute violations.

· A change has been made to the database so that the PDFINFO and PDFTRACKING tables are included in the export
process.  This means that reviews/audits exported from CAPRI will now contain the PDF reports and the user will not
need to reprint the reports for them to be uploaded into EDMS.

· The wording on the 15 – passenger drop down box has been modified to “Is the motor carrier of passengers subject to
the safety fitness procedures contained in 49 CFR part 385 subpart A, AND does it transport passengers in a
commercial motor vehicle”  Note that the drop down list choices and subsequent unfit rules have not been changed.

· A change has been made to correct a ‘Dataset not in edit or insert mode’ problem users were occasionally
experiencing on Part C.

· A new recommendation category ‘Passenger Carrier’ has been added to the database, this will enable users to assign
custom recommendations to the group.

· A change has been made on the Part A Miscellaneous tab so that ‘New Entrant Seminar’ can no longer be selected as
a location for Compliance Reviews.

· A spelling error on the word accidents in the Part B report has been corrected.

· Additional items have been added to the spell check entire review/audit option. The spell check entire review/audit is
available from within an open review/audit under the Edit menu.

· Asterisks have been added to the PASA to hide to the DOT number from the screen.  Users may click a show/hide
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button to view the DOT number as necessary.

· A pop-up warning message has been added on Safety Audits conducted on carriers who require a Hazardous Materials
Safety Permit.  Message is a warning only and will not prohibit the audit from being completed.

· Import from SAFETYNET option has been modified to fix an error that was being caused by a delay in returning the
directory name.

· A change has been made to the database so the second page of the proposed Safety Audit result report will print for all
division offices for failed audits.

· The default search in field has been set in Part B to Primary Section Number.

· A change has been made so that the Prosecution number and Compliant number can be entered for US territories.

· A message has been added to the Backup/Restore procedure to clarify the action that is occurring.  Previously there
was no message and the finish button was enabled appearing that the process was complete when it had not.

· The Part B reports language has been modified to meet the SAFETEA-LU 4114 requirements.

· The tab order on the Part A Misc tab has been modified to follow the logical flow of the form.

· CAPRI has been modified so that state and contract employees can perform audits on Canadian carriers.

· Locally Defined fields have been modified and updated so that additional field types may be used.

· Hours of Service Worksheet:

o On the Numbers Checked page the functionality has been restored that allows the user to click on a default box to
move a number to the “Days Checked” column.

o A change has been made to the ‘Hours and Violation by Date’ report to print the passenger driver violations.

o A change has been made so that when you start the Hours of Service worksheet intra-state only drivers will be
marked as such.

o The message on the bottom of the Hours page has been modified so that it is no longer running off the side of the
page.

o Worksheet has been updated to add an additional violation to the DVIR section.

o The DVIR report was modified to properly show the correct State and Federal data based on the driver type.

· Hazardous Materials Worksheet:
o A change has been made so that shipper related questions do not require a driver name to be selected.  In

addition, the report ‘Violation Summary’ has been changed to be called the ‘General Violations’ report.
· All Worksheets:

o A change has been made so that when violations are synchronized from the worksheets to Part B the long
violation description will be used instead of the short description.

o A change has been made so that when new violations are synchronized with Part B, Part B is marked as
incomplete.

1.5.3 CaseRite

CaseRite is designed to automate and improve the quality of the enforcement case preparation process. It is part of FMCSA's
suite of investigation software and shares data with CAPRI, UFA, and Aspen.

Fixes to CaseRite 3.7.3

· An error that occurred when importing a case that originated in CAPRI into CaseRite has been fixed.

Enhancements and Other Modifications to CaseRite 3.7.3

· The Violation Table has been updated.
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1.5.4 CDLIS Access

The Commercial Driver License Information System (CDLIS) Access is a network of state driver license systems linked via a
central site, which enables national access to any driver license status or history of safety violation convictions.

Fixes to CDLIS Access 3.4.1

· None

Enhancements and Other Modifications to CDLIS Access 3.4.1

· A pop-up message was added warning users to anticipate a possible long response time for more than 10 requests. 
The user can choose to remove this message by unchecking Network Traffic under the Notices Preference.

· When a CDLIS connection cannot be established, the following message appears: cannot connect to Authorized
Systems

· A.K.A. (not available for Canada or Mexico) searches may be performed by:

o Entering just the SSN

o Entering the First & Last Name and DOB

o Entering CDL# and State

· An onscreen message was added: Note: A.K.A. searches may be performed by entering just the SSN, or by entering
the First & Last Name and DOB, or by entering the CDL # and State. A.K.A. searches are not available for Canada or
Mexico. The user can choose to remove this message by unchecking A.K.A. Searches under the Notices Preference.

· A CONVID field was added to the Network version of the CDLIS Report.

· A W.D Pending field was added to the Network version of the CDLIS Report.

1.5.5 eFOTM

The electronic Field Operations Training Manual presents investigation procedures and techniques in an electronic format. The
manual is a tool to help you plan and complete simple, unusual, unique, and/or difficult investigations.

Fixes and Other Modifications to eFOTM 2.1

· An issue that interfered with the eFOTM automatic update functionality was discovered and a patch released on 9/5/07. To
download and apply the Automatic Update patch, click on your eFOTM desktop icon. There are two updates which you will
be prompted to make. You MUST accept these updates to apply the fixes. This fix does not alter or update the eFOTM
content, it is a patch to the update functionality that will allow future updates to function properly. 

Fixes and Other Modifications to eFOTM 2.2

· An issue that caused inconsistent behavior with the Next, Previous, and Top links has been fixed.  

Enhancements and Other Modifications to eFOTM 2.2

· The FMCSA address has been updated.  

· The following memos have been added:

o Amendment to CDLIS Sampling Criteria

o ASPEN Modifications for Implementation of the Cross Border Demonstration Project

o English Language Proficiency 

o Operations Directive: Significant Crash/Incident 

o Requirements for Inspection of Mexico-domiciled Carriers Operating under the Cross-Border Demonstration
Project
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1.5.6 ISS

The Inspection Selection System (ISS) enables screening of vehicles based on DOT number, MC/MX number, State number,
or carrier name. ISS returns the carrier name and address, an inspection value, and other decision indicators to help measure
the value of conducting an inspection. This install includes the most recent monthly database update.

Fixes to ISS 2.12

· None

Enhancements and Other Modifications to ISS 2.12

· The ISS data update message has been changed to "Your system requires a full database replacement; please
download and install the full database replacement from the InfoSys Website."

· An alert has been added to notify the user if a carrier is a Registrant.

· The carrier's Unified Carrier Registration (UCR) information, if available, is now displayed from the Details tab.

· The  ISS-D document (ISS-D Algorithm March 2007.pdf) has been updated.

1.5.7 PIQ

The Past Inspection Query (PIQ) accesses a national database of recent inspection reports. This database contains inspection
reports for the previous 180 days. PIQ retrieves an exact facsimile of previous inspection reports stored in the database.

Fixes to PIQ 2.9

· None

Enhancements and Other Modifications to PIQ 2.9

· Level VI information is now included on the PIQ report

1.5.8 Query Central

Query Central is an intelligent query system designed to dramatically increase access to motor carrier safety information for
State and Federal law enforcement personnel. 

Fixes to Query Central

· An issue that caused Query Central to leave the Hazmat and state information off the Inspection Report has been fixed

· An error that occurred that did not allow co-driver information to be entered when running Driver History search has
been fixed

· An issue that caused milepost information to populate with the MCMIS location code on the Inspection/Driver Vehicle
Examination Report has been fixed

· An issue that caused nonexistent Hazmat convictions to appear on the Driver Summary has been fixed

Enhancements and Other Modifications to Query Central

· L&I and Process Agent information can now be accessed by clicking the MC/MX number on the Carrier Summary page

· When a CDLIS connection cannot be established, the following message appears: cannot connect to Authorized
Systems

· Middle name and suffix fields have been added to the Driver Search page

· The default Query Type for driver queries has been changed from Status to AKA

· A.K.A. (not available for Canada or Mexico) searches may be performed by:

http://infosys.fmcsa.dot.gov/
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o Entering just the SSN

o Entering the First & Last Name and DOB

o Entering CDL# and State

· Query Central now allows users to choose whether to download the carrier's mailing address or physical address to
Aspen

· The alert Please check the CDL status has been added to the Driver Summary

· Query Central now shows an alert when a USDOT number is classified as Vehicle Registrant Only

· Level VI information is now included on the Inspection report

1.5.9 SAFETYNET

SAFETYNET is a system designed to manage and provide appropriate access to crash data, roadside inspection history and
data, and motor carrier and shipper identification information.

Enhancements and Other Modifications SAFETYNET

· Inspection Module Enhancements

o There are several enhancements to the collection of information for Level VI (Radiological) Inspections. Most
significantly, the additional radiological data collection is on the main inspection screen. Also, all violations are
saved in a single inspection violation table. Please consult the SAFETYNET User Manual, Chapter 4 Inspection
for details concerning these changes.

o During importing Aspen inspections, there is now a test for a valid Aspen version number, based on the inspection
date. Aspen inspections conducted after these dates will not be accepted by SAFETYNET:

ASPEN Version Latest Allowed Inspection
Date

2.6 March 31, 2007

2.7 March 31, 2007

2.8 October 31, 2007 

*The date October 31, 2007
is subject to change, based
on unresolved legal issues

with Hours of Service
violations. If changed, an

update script will be
distributed to SAFETYNET

sites.

o Inspections now have a flag to indicate the inspection was conducted as part of a PASA (Pre-Authority Safety
Audit).  This applies to Federal inspections only.

o The inspection data entry screen now applies numeric formatting to CVSA Decal entries.  CVSA decals are eight
digits values padded with leading zeros (e.g. '00000123').  Older non-numeric decal numbers, will display with no
formatting.

o The display of Inspection levels on the main grid and on some inspection reports now use Roman Numerals (I, II,
III…).  The data entry controls will continue to use numbers.

o The default text length for violation descriptions has increased to 162 characters.

o Added the trailer manufacturers H&H Trailer Company (NCIC Code “HHTC”) and  Reinke Manufacturing Co. Inc.
(NCIC Code “RNKE”) to the SAFETYNET lookup table.
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o Several inspection violations have been modified. As of this release, the hours of service violation for the 10-hour
rule for violations occurring on or after September 21, 2007 will be 395.3A1, and the violation code for the 11-hour
rule violation (Property) is 395.3A1/R.

· Enhancements to Crash Function

o The description of Cargo Body Type, 10 was changed to “10 Hopper (Grain, Chips, Gravel)” to be consistent with
the MMUCC.

· Report Changes

o Added a new report that provides a count of CVSA decals issued given a date range supplied by the user.  This
report is found under the SAFETYNET menu Reports -> Summary Reports -> Inspections with CVSA Decals.

o Modified the MCSAP Quarterly report to include the number of CVSA Decals issued during the quarter.

o If the user tried to generate the Local Carrier Profile Report using “include Archive Data”, an error message was
generated. The report now operates correctly when this option is selected.

· Communications Module

o In communications processing, automatically tag any new records added to the Out Box during the “Preparation”
of Inspections and Crashes.

· Carrier Search Module

o As part of Carrier Search resolution, added the Carrier’s phone number to the Carrier Search User Resolution
Screen to assist the user in verifying Carrier Information for each Inspection or Crash.

· System Administration

o The New Mexico division has been transferred from the Southern Service Center to the Western Service Center.
The SAFETYNET office lookup table was changed to reflect this assignment.

o A new office address for a second Louisiana office was added. The address of the FMCSA Virginia Division Office
has been updated.

1.5.10 UFA

The Uniform Fine Assessment (UFA) system is used for assessing fines for violations of the Federal Motor Carrier Safety and
Hazardous Materials Regulations. 

Changes to UFA 2.6.4

· None

Enhancements and Other Modifications to UFA 2.6.4

· The Violation Table has been updated.

1.6 Known Issues

All FMCSA Applications

Users downloading and installing FMCSA software for the first time on a new computer may see the following message:
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Click Run to continue.

1.7 Technical Support

This document may explain or identify many general questions or issues that you may have noticed with the FMCSA IT
Development Division applications. However, you may still have concerns or questions. For more information, contact the
FMCSA Technical Support Team:

Phone 617-494-3003 Hours: M-Th 8AM-8PM EST F 8AM-6PM EST

Fax 617-494-3058

Web site http://infosys.fmcsa.dot.gov/

Email FMCTechSup@volpe.dot.gov

http://infosys.fmcsa.dot.gov/
mailto:FMCTechSup@volpe.dot.gov
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